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Abstract: With the increase of the population of Sri Lanka, retrieving the family’s information process has been transformed into a 
highly complicated task in Divisional Secretariat offices, Grama Niladhari offices and NGOs. In order to get a particular person’s family 
details it is required to check some requirements such as National Identity Card (NIC) number and birth certificate number. 
Additionally, this task needs to be completed quickly and efficiently. But, it is a time consuming and most complex process in a manual 
system using papers or spreadsheets.  This paper presents an information system developed to achieve this task. Salient features of the 
system include reduce the difficulties arise when searching the information, keeps the details as records and able to display the tree. The 
hierarchical details of the family could be viewed through the tree model. The system was tested with randomly selected some family 
details. The test results indicated that the system functions accurately and efficiently.  
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1. Introduction 
 
Many government organizations and NGOs in Sri Lanka use 
family information as a basis to their day to day works. It is 
very important that providing quality services, creating 
customer confidence, and making timely decisions. As such, 
information technology has become the prime reason for the 
success and failure of an organization to compete in business. 
This illustrates the impact of information technology on 
business operations today. As a result, designing an 
information system of high quality is important so that 
organizations can process successfully for national 
development. This paper proposes a new information system 
to handle the family information to process the Divisional 
Secretariat offices, Grama Niladhari offices and NGOs in Sri 
Lanka. 
 
Software is not just the programs. Software includes all 
associated documentation and configuration data that is 
needed to make the programs operate correctly. A software 
system usually consists of a number of separate programs, 
configuration files which are used to setup these programs, 
system documentation which describes the structure of the 
system, user documentation which explains how to use the 
system and websites for users to download recent product 
information [1]. 
 
We have designed a software tool to maintain the details of a 
family or a particular person. The purpose of the software is 
to reduce the difficulties arise when searching the 
information. This software keeps the details as records. It is 
easy to keep the computerized records than keeping manual 
records. This software can be used in Divisional Secretariat 
offices, Grama Niladhari offices and NGOs.  
 
The main interface is the login interface. The software is 
accessed by entering the username and correct password. The 
next interface is used to search details, edit details , save 
details, insert details of a new born baby, add new details, 
create user ID, change password, find the time of  login and 
logout. If we enter the ID of a particular person and press the 

button GO it will display the details of that person and view 
the tree model.  
 
It is also be able to display the tree. The hierarchical details 
of the family could be viewed through the tree model. The 
important menus used in this interface are Edit, View, Insert, 
User, Login and Help. We can edit the basic details, sex, civil 
status, religion, educational qualification, professional 
qualification and etc. The details can be saved. If we want to 
change any information it is possible to do that by reset 
button.  It is also be able to edit details of a new born baby 
and add new details for others. The software is designed to 
maintain a user ID for each and every person. The password 
can be changed and the given ID can be deleted. There is 
another facility to know about who accessed the software 
recently and last accessed time. This is performed with the 
use of login and logout menus. It also includes a help menu 
which describes about the software and provides guidelines 
about how to use the software. 
 
We have designed the interfaces of this software using Visual 
Studio.NET 2008 through the C# language and database is 
maintained through SQL server 2005 [4]. We hope this 
software will be useful to keep the details as records. 
 
2. Material and Methods 
 
In order to develop the Family information system following 
methodology is used:  
 
(i) Gathering requirements; 
(ii) Specifying, constructing, visualizing and documenting 

the artifacts of the system by using the Unified Modeling 
Language (UML); 

(iii) Microsoft Visual Studio is used as an Integrated 
Development Environment (IDE) to develop the 
graphical user interface of the system; 

(iv) Designing the database is maintained using SQL server 
2005;  

(v) Generating the test cases and testing the outputs. 
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3. Analysis and Design 
 
First we planned to monitor the possible part of the system 
and display the performance of the particular part. We 
analyzed each and every attributes, concerned about 
important details and created an interface to each of the 
operation. 
 
3.1. Requirements Analysis 
 
We discussed with the users and gathered the needed and 
important information which should be kept as records. We 
analysed whether this software will be useful for them and 
provide better advantages. 
 
• Editing the details and saving them. 
• Keeping the available information as records. 
• Display the hierarchical tree model.  
 
3.2. Functional Requirements 
 
• Edit the details. 
• Save the details. 
• Insert additional details. 
• Keep details as records. 
• Maintain user ID. 
• Maintain the login details. 
• Display hierarchical tree model. 
 
3.3. Non Functional Requirements 
 
• Visual studio.NET 2008 
• SQL server 2005 
 
3.4. Use Case Diagram 
 

 
Figure 1: Use cases of the tool 

 
The actor indicates the administrator who accesses this 
software. The use cases indicate the main functions 
performed in this software. 
 
 
 
 
 
 
 

3.5. Activity Diagrams 
 

 
Figure 2: Describes about how to access this software. The 

user has to enter the user name and password. If both are 
valid user can access the software. Otherwise he has to try 

again. 
 

 
Figure 3: Describes about how to use the Edit menu. First 

user has to click the Edit menu and enter the valid identity. If 
the identification is invalid he has to try again. If it is valid he 

can edit the details. After editing if he wants to continue he 
has to click the NEXT button otherwise click the CANCEL 

button. 
 

 
Figure 4: Describes about how to search the details. First the 
user has to enter the family ID. If the ID is invalid he has to 

try again. Otherwise he has to enter the GO button. The result 
of this function is the information is displayed and 

hierarchical tree model is viewed 
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Figure 5: Describes about how to use the Insert menu. If the 
user is above 18 years he has to enter the NIC number and 

the user is below 18 years he has to enter the Birth Certificate 
number. After that he can edit the details. If he wants to 

continue the function click the NEXT button otherwise click 
CLOSE button. 

 

 
Figure 6: Describes about how to use the User menu. There 
are two options. The user can create a password and change 
the password. If the user wants to create a password he can 

click the CREATE button and he can also reset the password 
using RESET button. If the user wants to change the 

password he can click the CHANGE button otherwise click 
CLOSE button. 

 
4. Testing and Evaluation 
 
Software testing consists of the verification of the behavior of 
a program. The first few revisions tested to verify that the 
software system would operate correctly. The testing was 
made to ensure that the software system confirms to its 
specification. The testing produced desirable results. The 
software validated and tested with appropriate inputs to 
ensure that it has produced desirable outputs. The NIC 
number and Birth Certificate number are used to check the 
data validity. 
 
Edit menu - Edit the details of a person. 
View menu - Display the charts for each and every category. 
Insert menu - Insert details of a new born baby and add new 
details for others. 
User menu - Maintain user ID and password. 
Login menu - Maintain the details of login and logout. 
Help menu - Providing guidelines to use the software. 

5. User Interface Design 
 
User interface of Family Information System is designed to 
provide a simple and an attractive graphical interface to 
users. The main interface is the login interface. The software 
is accessed by entering the username and correct password. 
The next interface is used to search details, edit details , save 
details, insert details of a new born baby, add new details, 
create user ID, change password, find the time of  login and 
logout. If we enter the ID of a particular person and press the 
button GO it will display the details of that person and view 
the tree model. It is also be able to display the tree. The 
hierarchical details of the family could be viewed through the 
tree model [3]. The important menus used in this interface are 
Edit, View, Insert, User, Login and Help. 
 

 
Figure 7: Main GUI for Admin user 

 
 We can edit the basic details, sex, civil status, religion, 
educational qualification, professional qualification and etc. 
The details can be saved. If we want to change any 
information it is possible to do that by reset button.  It is also 
be able to edit details of a new born baby and add new details 
for others. The software is designed to maintain a user ID for 
each and every person. The password can be changed and the 
given ID can be deleted.  
 

 
Figure 8: Insertion of personal details of a person 
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There is another facility to know about who accessed the 
software recently and last accessed time. This is performed 
with the use of login and logout menus. It also includes a 
help menu which describes about the software and provides 
guidelines about how to use the software. 
 
6. Results and Discussion  
 
The system developed was tested with sample of some family 
information. Software testing consists of the verification of 
the behavior of a program. The first few revisions tested to 
verify that the software system would operate correctly. The 
testing was made to ensure that the software system confirms 
to its specification. Thetesting produced desirable results. 
 

 
Figure 9: View Statistical Information 

 
The software validated and tested with appropriate inputs to 
ensure that it has produced desirable outputs [2]. The NIC 
number and Birth Certificate number are used to check the 
data validity. An example test data is shown in figure 10. 
Finally the test results were compared with manually tested 
results to check the accuracy of the information system. The 
test results indicated that the analysis of result is accurate, 
efficient and consistent. 
 

 
Figure 10: Search result validation 

 
7. Conclusions 
 
An information system developed can be used to replace the 
current inefficient and time consuming manual system. The 
system developed analysis family’s information efficiently 
and accurately. Since the new system is a desktop application 

it provides flexibility to both the staff members and the 
public people.  The fast analysis and quick search results 
gives the details of searching query quickly. The system 
developed can be customized to analyze the family 
information at any state organization. 
 
References 
 
[1] Hentry C. L., TheAnalysis, Design and Implementation 

of Information Systems, Mc-Graw Hill, 4th Editions, 
New York, USA (1992). 

[2] Kodituwakku S. R., Chamikara P, CUBRAS: Design and 
Implementation of the Course unit based Result and 
Analysis System, Ceylon Journal of Physical Sciences, 
15, 27-39 (2009). 

[3] Davis H., Visual C# .Net Programming, Sybex (2002). 
[4] Watt A., Microsoft SQL Server 2005 for Dummies, 

Wiley Publishing, inc., (2006). 
 
Author Profile 
 

U. Priyatharsan received the BSc (Hons) in 
Applied Mathematics and Computing from 
Vavuniya Campus of the University of Jaffna, Sri 
Lanka in 2010. He is currently reading MSc in 

Information Technology (Specialized in Cyber Security) 
from Sri Lanka Institute of Information technology, Sri 
Lanka. From 2011, he is working as a Lecturer in Vavuniya 
Campus of the University of Jaffna, Sri Lanka. 
 

P. Hemija Sarawana received the BSc (Hons) in 
Information and Communication Technology 
from Vavuniya Campus of the University of 
Jaffna, Sri Lanka in 2014. Currently, she is 

working as a Demonstrator in Vavuniya Campus of the 
University of Jaffna, Sri Lanka 

Paper ID: SUB14372 975

http://creativecommons.org/licenses/by/4.0/�

	Introduction
	Material and Methods
	/
	User Interface Design



